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How much does TwistedBrush Pro Studio cost?How much does TwistedBrush Pro Studio cost?

Visit the Pixarra Online Store to see the current prices.
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How do I purchase TwistedBrush Pro Studio?How do I purchase TwistedBrush Pro Studio?

Visit the Pixarra Online Store and select a product.
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Can you explain the different licenses that areCan you explain the different licenses that are
available or were previously available?available or were previously available?

• Version license with free upgrades for current major versionVersion license with free upgrades for current major version: The software will never
expire. Free updates are available for the current major version (24.x) for example.
Upgrades to the next major version will be available for a fee. This is the standard way
most consumer software is sold.

• Perpetual with free upgrades for the life of the product:Perpetual with free upgrades for the life of the product: The software will never expire.
The customers will receive free upgrades not only within the current major version (24.x)
but also for all future major versions (25, 26, etc.).

• 6 Month license6 Month license: This license is no longer available for purchase. Software will be usable
for 6 months, during which time updates are free. After 6 months, a new license must be
purchased to continue to use the software.

• 1 Year license1 Year license: This license is no longer available for purchase. Software will be usable
for 1 year, during which time updates are free. After 1 year, a new license must be
purchased to continue to use this software.
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After I purchase TwistedBrush, what happensAfter I purchase TwistedBrush, what happens
next?next?

You will receive a license key at your supplied email address, usually within minutes of
purchasing the product. When you get your license key, use it to fully activate TwistedBrush
Pro Studio. You can activate the version of TwistedBrush Pro Studio you already installed as
a trial or you can download and install the latest version.
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I have my license key. Where do I download myI have my license key. Where do I download my
TwistedBrush software?TwistedBrush software?

You can download the latest version of the product that you purchased from the Pixarra
website at:
http://www.pixarra.com/download.html
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As an owner of TwistedBrush can I useAs an owner of TwistedBrush can I use
TwistedBrush Pro Studio?TwistedBrush Pro Studio?

Yes, all TwistedBrush owners may download and use TwistedBrush Pro Studio as long as
your license if still valid. It's the new name for TwistedBrush. Your existing TwistedBrush
license will continue to be valid for TwistedBrush Pro Studio.
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Is there an upgrade path from TwistedBrushIs there an upgrade path from TwistedBrush
Open Studio to TwistedBrush Pro Studio?Open Studio to TwistedBrush Pro Studio?

If you have purchased brushed for TwistedBrush Open Studio and want to upgrade to
TwistedBrush Pro Studio contact us at support@pixarra.com for details about your
available upgrade discount.
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How do I purchase TwistedBrush as a gift forHow do I purchase TwistedBrush as a gift for
someone else?someone else?

To purchase TwistedBrush as a gift for someone else, go through the standard order
process. After you receive your purchase confirmation, email Pixarra support via email at
support@pixarra.com. In this email include your full name, email address or order number
and indicate that your recent purchase is intended to be a gift and include the recipient's
full name. A license key in his or her name will be returned to you via email. At that point,
you can present the license key as a gift in any way you like. You may wish, for example, to
include the license number and the link to download the new software in a traditional
greeting card or in an email.
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Can I just send you my credit card informationCan I just send you my credit card information
in email?in email?

No. Please use the order page at the Pixarra Online Store. From there, once you select the
product you wish to purchase, you will find numerous purchase options. These are all
handled by the payment processing center, Plimus.

Page 15Page 15TwistedBrush Pro Studio FAQ

http://www.pixarra.com/order.html


What payment options are available?What payment options are available?

These payment options are available: secure online credit card, phone-in credit card, fax,
mailed money order, mailed check, wire transfer, purchase order, or PayPal.
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Can I have a CD mailed to me for my purchase?Can I have a CD mailed to me for my purchase?

We don't offer this option because our frequent updates would likely make the CD version
out of date before it reaches you. We're vigilant about keeping the download size of the
application small. Currently, the full download of TwistedBrush is about 16mb.
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TwistedBrush EditionsTwistedBrush Editions
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What are the different editions of TwistedBrushWhat are the different editions of TwistedBrush
that are available?that are available?

Currently there are 2 editions available, TwistedBrush Pro Studio and TwistedBrush Open
Studio. TwistedBrush Pro Studio is everything, all features and all brushes (over 8000 at this
point). TwistedBrush Open Studio is a free version of TwistedBrush with many of the
feature of Pro Studio and just a handful of very fine brushes with the ability to purchase
additional brush collections.
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Is TwistedBrush Open Studio really free?Is TwistedBrush Open Studio really free?

Yes, really! TwistedBrush Open Studio has many of the great features of TwistedBrush Pro
Studio but just a handful of very fine brushes but no ability to edit brushes.
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Why did Pixarra include so many great featuresWhy did Pixarra include so many great features
in a free version of TwistedBrush?in a free version of TwistedBrush?

It is our hope that more and more people will use TwistedBrush and that a very feature
packed free version will accomplish this. Of course beyond that we would hope those users
will be inspired to purchase additional brush collections for Open Studio or move up to Pro
Studio.
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If I already have purchased TwistedBrush ProIf I already have purchased TwistedBrush Pro
Studio is there any reason to install or useStudio is there any reason to install or use
TwistedBrush Open Studio?TwistedBrush Open Studio?

Not really, TwistedBrush Pro Studio includes everything that TwistedBrush has to offer plus
all the brushes and the ability to edit and install user created brushes.
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Should I buy TwistedBrush Pro Studio orShould I buy TwistedBrush Pro Studio or
TwistedBrush Open Studio and some of theTwistedBrush Open Studio and some of the
brush collections?brush collections?

TwistedBrush Pro Studio has more advanced features and more control. However,
TwistedBrush Open Studio has a lower starting cost - free, plus small incremental costs if
you decide to purchase additional brushes. The brushes purchased for TwistedBrush Open
Studio will not expire. If you have purchased brushes for TwistedBrush Open Studio and
later decide to move up to TwistedBrush Pro Studio ask about an upgrade discount to do
this.
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Can I install TwistedBrush Pro Studio brushesCan I install TwistedBrush Pro Studio brushes
into TwistedBrush Open Studio?into TwistedBrush Open Studio?

No, TwistedBrush Pro Studio ArtSets and user created brushes and ArtSets will not work in
TwistedBrush Open Studio.
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How is TwistedBrush Open Studio differentHow is TwistedBrush Open Studio different
than TwistedBrush Free Edition that used to bethan TwistedBrush Free Edition that used to be
available?available?

There are major differences. Whereas the previous Free Edition was very limited, Open
Studio has a wealth of features. For example TwistedBrush Open Studio can import images,
all TwistedBrush filters are available, all the tools (too many to list are available), layers,
masks, etc are available all of which were not available in the previous Free Edition.
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TwistedBrush Help andTwistedBrush Help and
FeaturesFeatures
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Is there a free trial of TwistedBrush?Is there a free trial of TwistedBrush?

Yes, TwistedBrush Pro Studio has a free, fully featured 15-day trial. You can download it
here.

Page 27Page 27TwistedBrush Pro Studio FAQ

http://www.pixarra.com/download.html


Is there an Extended trial of TwistedBrush?Is there an Extended trial of TwistedBrush?

Yes, an extended free trial of TwistedBrush exists. It allows for full usage for 30 days. You
can sign up for the extended trial here.
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How do I use a specific feature?How do I use a specific feature?

Please see the TwistedBrush Pro Studio User Guide.
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I couldn't find information in the User GuideI couldn't find information in the User Guide
about how to do something. Where should I goabout how to do something. Where should I go
for help?for help?

Posting a new topic in the Pixarra Forum often leads to the best and fastest response to
your question. If you are wondering about something, chances are good that other people
are wondering the same thing.
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How do I suggest a new feature or a featureHow do I suggest a new feature or a feature
enhancement to TwistedBrush?enhancement to TwistedBrush?

The best place to suggest a feature is in the Feature Request section of the forum.
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Is there a Mac version of TwistedBrush?Is there a Mac version of TwistedBrush?

Right now, TwistedBrush is a Windows only product. It is possible to run Windows programs
on more recent Macs by using Boot Camp, VMware Fusion or Parallels Desktop.
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Is there a iPad or Android tablet version ofIs there a iPad or Android tablet version of
TwistedBrush?TwistedBrush?

TwistedBrush is a Windows only product this at time. It is possible to fully access your
Windows system and run TwistedBrush remotely via solutions such as Splashtop Remote.
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Are drawing tablets supported inAre drawing tablets supported in
TwistedBrush?TwistedBrush?

Yes. tablets that conform to the Wintab tablet specification are supported in TwistedBrush.
This means that most all drawing tablets are supported.
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What new features are coming up in a futureWhat new features are coming up in a future
release?release?

We usually don't announce features ahead of time. However, if a feature or fix is completed
and just not released yet, it will likely appear in the Revision History section of the
Reference Manual.
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Are tutorials for videos available?Are tutorials for videos available?

Yes these can be found in the TwistedBrush Pro Studio Videos manual.
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Problems and IssuesProblems and Issues
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I've run into a problem with the TwistedBrushI've run into a problem with the TwistedBrush
software. Where should I report the problem?software. Where should I report the problem?

The best place to report a problem with your TwistedBrush software is in the Problem
Report section of the forum.
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When I report a problem with TwistedBrush,When I report a problem with TwistedBrush,
what information should I include?what information should I include?

Please include as much information as you can about how the problem occurred.
Describing the exact steps you took to get the problem to occur helps a great deal. In your
report please state the version of Windows that are you using. The version of TwistedBrush
and the edition of TwistedBrush (TwistedBrush Pro Studio or TwistedBrush Open Studio)
that you are using should also be listed. If it seems appropriate, include a screen shot of the
problem. If it's a crash, post the log.txt file that is found in the TwistedBrush directory.
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I was using TwistedBrush just fine for a while,I was using TwistedBrush just fine for a while,
but then things starting moving slowly. What'sbut then things starting moving slowly. What's
happening?happening?

It is possible that your PC is running low on memory. This can happen if you are using a lot
of layers and working on large-sized pages.
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I seem to be running low on memory whenI seem to be running low on memory when
running TwistedBrush. Is there anything I canrunning TwistedBrush. Is there anything I can
do to improve this situation?do to improve this situation?

Yes. There are a number of things that can be done to improve this situation in the short-
term. There are ways to try to keep it from happening in the future, too. For short-term
improvement:

• Close other applications that are open and not being used.
• Merge layers that are no longer needed to be separate.
• Clear the undo information if you don't need to undo any current steps. Use the menu

Control > Clear Stored Undo StepsControl > Clear Stored Undo Steps.
• Move to a new page and return to your current page.
• Use a smaller brush size.
• Exit from TwistedBrush and start it back up if you are still having problems.

If you continually run low on memory while using TwistedBrush, you can:

• Purchase more memory for your computer.
• Work on smaller page sizes in TwistedBrush.
• Set the Max Undo Levels to a smaller number through the menu Edit > PreferenceEdit > Preferences.

Alternatively if you are running Windows XP or Vista (32 bit Editions) there is a system level
setting within Windows to allow for applications to have access to more memory. The
switch is called 3GB and will allow TwistedBrush versions 16.01 and later access to 3GB or
memory instead of the standard 2GB. Search the microsoft support forums on the internet
for information on setting this switch for your version of Windows.

If you still need access to more memory you can install TwistedBrush on Windows (XP, Vista
or 7) 64 bit editions and this will give TwistedBrush up to 4GB of memory in TwistedBrush
versions 16.01 and later.
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My drawing cursor doesn't match up with paintMy drawing cursor doesn't match up with paint
strokes when I'm using my drawing tablet. Isstrokes when I'm using my drawing tablet. Is
there a way to adjust this?there a way to adjust this?

Yes. Make sure that your pointing device is set up for absolute position in your tablet driver
settings. This setting is sometimes called Pen mode. Either way, you should be able to
access this setting in the Windows Control Panel application that was installed with your
tablet. You can also turn on Tablet Compatibility Mode in TwistedBrush. This can be found
in the Preferences dialog. Access the Preferences dialog from the menu Edit > Preferences.
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CompatibilityCompatibility
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What does Win32DPNetGame error mean?What does Win32DPNetGame error mean?

Yes. Windows may request permission to install the DirectPlay component. This is normal.
Here is additional information on this.

http://msdn.microsoft.com/en-us/library/windows/desktop/dn323745%28v=vs.85%29.aspx

If Windows is configured to not automatically install optional components an error may be
reported as unable to start Win32DPNetGame. In this case you may need to manually
enable the DirectPlay functionality of Windows.

Control panel -> Programs -> Programs and Features -> Turn windows features on or off
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Is TwistedBrush compatible with Windows VistaIs TwistedBrush compatible with Windows Vista
and Windows 7?and Windows 7?

Yes
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I'm getting a DEP (Data Execution Protection)I'm getting a DEP (Data Execution Protection)
error when I run TwistedBrush on Windowserror when I run TwistedBrush on Windows
Vista or Windows 7, how do I correct this?Vista or Windows 7, how do I correct this?

Make sure you are using the latest version of TwistedBrush version 17 or later.

For older versions of TwistedBrush set DEP to only manage Windows services and internal
programs.

Alternately you can keep the setting for DEP on for all programs and add tbrush.exe to the
list of exceptions.
Click the [Add] button and browse to tbrush.exe, usually in "C:\Program Files\Pixarra\
TwistedBrush" and say Open, double check that it is now in the list and checked, and then
say OK
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TwistedBrush is not starting after the splashTwistedBrush is not starting after the splash
screen, what's wrong?screen, what's wrong?

There are a few different things that could cause this.

• The PC Tablet service is running. You may need to manually stop the PC Tablet service.
• Your anti-virus software may be terminating the TwistedBrush. Adjust your anti-virus

software to allow TwistedBrush or disable temporarily to test if that is the issue.
• Other software running on your system is incompatible with TwistedBrush. Start

Windows in Safe Mode and test if TwistedBrush starts normally. If it does then it is likely
other software is conflicting with TwistedBrush in a normal start.

• The configuration of TwistedBrush may be faulty. Please remove the file
TwistedBrush.env and start TwistedBrush.

• If still having an issue you can install TwistedBrush into a different directory.
• On a very small percentage of Windows Vista systems the auto switching from Aero to

Vista Basic color themes doesn't work. This is purely a Windows function, TwistedBrush
isn't doing or actually even requesting it but Windows determines it needs to be done
based on the features of the OS that TwistedBrush uses. Manually switch from the Aero
theme to the Vista Basic theme before starting TwistedBrush to see if that is the
problem.
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TwistedBrush is not starting on my WindowsTwistedBrush is not starting on my Windows
Vista or Windows 7 system.Vista or Windows 7 system.

See topics for working with start-up issues.
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When I open up the Tablet PC Input Panel inWhen I open up the Tablet PC Input Panel in
Vista or Windows 7 TwistedBrush closes, why?Vista or Windows 7 TwistedBrush closes, why?

There is a compatibility issue with the Tablet PC Input Panel and TwistedBrush that can
result in this behavior. Note, installing a Wacom tablet will also enable the Tablet PC Input
Panel in case you don't have a keyboard. To reduce the chance of accidentally opening the
Tablet PC Input Panel which is docked on the side of your desktop, you can disable it.
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Where are my images (pages and books) storedWhere are my images (pages and books) stored
on Windows Vista and Windows 7?on Windows Vista and Windows 7?

TwistedBrush creates folders named Book1, Book2, etc under the TwistedBrush folder. On
Windows Vista and Windows 7 depending on your UAC (User Account Control) these are
stored elsewhere by the operating system and tagged as Compatibility files. Here's a link
with further information on seeing this files:

http://www.pcmag.com/article2/0,2817,2124519,00.asp

On Windows Vista and Windows 7 you should find the files created from within
TwistedBrush in the Virtual Store. For example this would be at

c:\Users\username\AppData\Local\VirtualStore\Program Files\Pixarra\TwistedBrush\

Windows Vista and Windows 7 place user files that are created in a secure location not
within the real Program Files. Note in the path above replace username with whatever your
user name is on your system.

Also see this item: Where are my TwistedBrush data files stored on Windows 7?

Page 50Page 50TwistedBrush Pro Studio FAQ

http://www.pcmag.com/article2/0,2817,2124519,00.asp
43705?resolve=true


Where are my TwistedBrush data files storedWhere are my TwistedBrush data files stored
on Windows 7?on Windows 7?

On Windows 7 user files are saved in the Virtual Store rather than in the Program Files
location.

For example this would be at:

On 32 bit Windows
c:\Users\usernameusername\AppData\Local\VirtualStore\Program Files\Pixarra\TwistedBrush\

On 64 bit Windows
c:\Users\usernameusername\AppData\Local\VirtualStore\Program Files (x86)\Pixarra\TwistedBrush\

In place of usernameusername you would use your Windows user name.

In sub directories of this location you will find your books (and pages/images), filter presets,
clips, ArtSets and Scripts.
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Can I keep my pages and custom ArtSets storedCan I keep my pages and custom ArtSets stored
in the TwistedBrush installation folder whenin the TwistedBrush installation folder when
running Windows Vista or Windows 7?running Windows Vista or Windows 7?

Yes, you can choose to run TwistedBrush as an administrator in which case the pages in
your books and custom ArtSets will be stored under the installation location for
TwistedBrush. Just like they do on Windows XP.

Right click the TwistedBrush shortcut on your desktop and choose Properties and set
compatibility to Run as Administrator

When running a program with administrator rights in Windows Vista or Windows 7 the
default is to prompt for your approval each time that program starts. It is possible to
disable that as well by during off User Account Control for the user account in question. But
this isn't required and turns off one of the security features of Windows.
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Will TwistedBrush run properly on an UMPCWill TwistedBrush run properly on an UMPC
(Ultra Mobile PC)?(Ultra Mobile PC)?

Yes, TwistedBrush is fully functional and will dynamically adjust the user interface for
systems with screen resolutions as low as 1024x600.
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Will TwistedBrush run properly on a myWill TwistedBrush run properly on a my
netbook computer?netbook computer?

Yes, TwistedBrush is fully functional and will dynamically adjust the user interface for
systems with screen resolutions as low as 1024x600.
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When I start TwistedBrush in Windows Vista orWhen I start TwistedBrush in Windows Vista or
Windows 7 I get a warning that the colorWindows 7 I get a warning that the color
scheme needs to change, is this normal?scheme needs to change, is this normal?

Windows Aero schemes are not compatible with all Windows applications. When Windows
detects the need to switch modes it changes the color scheme to the standard color
scheme until TwistedBrush exits. This does not impact the proper function of TwistedBrush
or other applications running.

Starting in version 18.14 for TwistedBrush Pro Studio the option to disable Windows Aero
on start up of TwistedBrush is exposed. This means you can allow TwistedBrush Pro Studio
to keep the Windows Aero theme. This option is available in the Preferences dialog.
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Every time I select an item from a list in theEvery time I select an item from a list in the
Brush Select dialog I hear a beep (ding) whenBrush Select dialog I hear a beep (ding) when
using Vista, how do I stop the dings?using Vista, how do I stop the dings?

This is a Vista issue. Here is the link to the Microsoft knowledge base article with
information on correcting it on your system by editing the registry.
http://support.microsoft.com/kb/944150
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Installation and UpgradesInstallation and Upgrades
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Can I install TwistedBrush Pro Studio on aCan I install TwistedBrush Pro Studio on a
second computer?second computer?

Your TwistedBrush Pro Studio license key lets you install the program on one or two
computers, as long as the program runs on only one of these computers at a time by the
purchaser of the software.
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How do I uninstall TwistedBrush?How do I uninstall TwistedBrush?

Use the standard Windows uninstall procedure. From Windows Control Panel, select Add or
Remove Programs. There, select TwistedBrush.
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If I uninstall TwistedBrush what happens to myIf I uninstall TwistedBrush what happens to my
artwork?artwork?

If you uninstall TwistedBrush your artwork remains on your computer. All artwork that you
create in TwistedBrush is stored in folders under the main TwistedBrush folder. These
folders are labeled Book1, Book2, Book3 etc and correspond to the books within
TwistedBrush. Files for each page are stored within these folders, including the .TBR file,
which is the TwistedBrush image format. A BMP file for each page is also included so you
have a file version that can be loaded into virtually any other Windows art program.

Also see this topic: Where are my images (pages and books) stored on Windows Vista and
Windows 7?
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Do I have to install every update that isDo I have to install every update that is
released?released?

No. You may skip any number of updates if you want and install an update only when you
are ready. Each release includes the additions and fixes from all previous updates.
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How do I know if a new release is available?How do I know if a new release is available?

New release announcements are made in the Company News section of the forum The
Download page on the Pixarra website shows the latest version.
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Where do I download the updates?Where do I download the updates?

The latest version of TwistedBrush can always be downloaded from the Pixarra Download
page.
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After a new release of TwistedBrush, can I use itAfter a new release of TwistedBrush, can I use it
as a trial again?as a trial again?

The trial expired indication is not reset on new releases of TwistedBrush. From time to time,
a new Extended Trial key will be made available to give those whom have already evaluated
the software another opportunity to evaluate it.
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How often are updates released?How often are updates released?

At the time of this writing, updates are released about every 2 or 3 weeks.
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I've installed the latest version of TwistedBrushI've installed the latest version of TwistedBrush
over my previous version and I don't see theover my previous version and I don't see the
new brushes?new brushes?

If you edit a standard TwistedBrush ArtSet on Windows Vista or Windows 7 the ArtSet file is
copied to the Virtual Store which is a Windows security measure. Now you have the edited
ArtSet in the Virtual Store and the original ArtSet in the TwistedBrush\ArtSet folder. When
an update installation occurs the original Artset is updated however Windows will only
point to the edited ArtSet in the Virtual Store. To remedy this situation you can manually
delete the ArtSet file in question from the following location.

\desktop\username\AppData\Local\VirtualStore\Program Files\Pixarra\TwistedBrush\ArtSet

Note if you are running the 64 bit version of Windows the location will be
\desktop\username\AppData\Local\VirtualStore\Program Files (x86)\Pixarra\TwistedBrush\
ArtSet
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I've installed the next major release ofI've installed the next major release of
TwistedBrush without purchasing an upgradedTwistedBrush without purchasing an upgraded
and now my license key says it's expired, whatand now my license key says it's expired, what
can I do?can I do?

You will have a number of days to try out the latest version at which point you can either
purchase the upgrade or download the previous major version from the Pixarra website. If
you don't wish to upgrade and instead install the old version you may need to request a
replacement license key that was disabled during the upgrade to the new version. You can
request the replacement key from support@pixarra.com.
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How to move your TwistedBrush storage folderHow to move your TwistedBrush storage folder
to a different drive?to a different drive?
You can move your TwistedBrush storage folder to a different or virtual drive by creating a
junction (mklink) that will redirect calls to/from a directory from/to another directory: e.g.
mklink /J "C:\Program Files (x86)\Pixarra\TwistedBrush\Book1" "E:\datadrive\
TwistedBrushBooks\Book1". Then you have to move all your existing files on the (C) directory to
the (E) drive directory. Any call from a program to the default (C) directory is redirected to the
(E) directory without the program being aware of the redirection.

If you need to remove the junction, you have simply to delete it and put all the files back on the
(C) directory.

You can find more information about the mklink on the Microsoft help page:
https://docs.microsoft.com/en-us/windows-server/administration/windows-commands/mklink
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What is a license key?What is a license key?

The license key is a special sequence of numbers and letters generated at the time of
purchase. It is tied to your name and is used to fully activate TwistedBrush Pro Studio and
allows continued usage of the software.
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Where do I get my license key?Where do I get my license key?

Normally you will receive your license key by email within minutes of your purchase. Make
sure you use a correct email address when you place your order. If you don't see the email
in your inbox be sure to check your junk / spam folder in case the email was filtered.
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What does a license key look like?What does a license key look like?

This nonfunctional sample shows what a license key looks like:

PR24-Q2L5-0000-T55L-L1L7

The license key for TwistedBrush Pro Studio versions 1-22 comprises two components:
Your Name
3A56-8B1F-B210-D233-981B-575B-44DE-80CA-1C11-F283
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That's a long license key. How do I enter that?That's a long license key. How do I enter that?

Highlight (select) the license key right in your email. Then, to insert it in the key-entry dialog
in your TwistedBrush program, use the Windows copy-and-paste functionality--Ctrl+c to
copy and Ctrl+v to paste. Make sure you enter your first and last name exactly as they were
listed in your purchase order. They must match for the license key to work.

Also see the License Key topic in the User Guide.
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Where do I enter the license key?Where do I enter the license key?

When you start a trial mode of TwistedBrush, you will be presented with a dialog box that
has an option to Enter Key. If you are currently running TwistedBrush, you can enter the
license key from the menu File > Enter License.

Also see the License Key topic in the User Guide.
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What's the difference between a license key,What's the difference between a license key,
activation code, serial number, and registrationactivation code, serial number, and registration
key?key?

There is no difference. They all are the same thing.
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My license key didn't work. Now what?My license key didn't work. Now what?

Make sure you have installed the latest release of the edition of TwistedBrush that you
purchased. Also, make sure the name that's entered exactly matches the name used during
purchase. Use the Windows copy-and paste functionality to insert the key and name into
the entry fields to reduce the chance of errors.
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My computer crashed and I have to installMy computer crashed and I have to install
Windows and all of my software. I don't haveWindows and all of my software. I don't have
my license key anymore. Now what?my license key anymore. Now what?

It is always best to keep a backup or printed copy of your license key in case you have to re-
enter it. If you can't locate it, you can use the automated support options below.

For purchases after 03/2007 http://home.plimus.com/ecommerce/shoppers/customer-
support

For purchases before 04/2007 http://shopper.esellerate.net/ics/support/
default.asp?deptID=5620
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Forum and GalleryForum and Gallery

Page 78Page 78TwistedBrush Pro Studio FAQ



Where is the TwistedBrush forum?Where is the TwistedBrush forum?

The forum is located at http://forum.pixarra.com
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Do I have to purchase TwistedBrush to registerDo I have to purchase TwistedBrush to register
and be active in the forum?and be active in the forum?

No, everyone is welcome and encouraged to visit and join the forum.
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Where is the gallery?Where is the gallery?

The gallery is part of the forum and can be accessed from the Gallery link near the top of
the forum pages.
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How do I register for the forum?How do I register for the forum?

When you visit the forum, there is a link near the top called Register. Once you click on it,
you will be guided in how to complete your registration.
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Why can't I post in the forum or gallery?Why can't I post in the forum or gallery?

Normally, this will be because you are not registered in the forum or you aren't currently
logged in. Posting in the forum and gallery requires that you be logged in.
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When tried to upload my painting into theWhen tried to upload my painting into the
gallery, I got an error. Why?gallery, I got an error. Why?

This could be happening for a few reasons. First, make sure you are logged in. Then, make
sure you are trying to upload with a JPEG or PNG file type. Make sure the size of the image
is less than 1mb.
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Where do I post a TwistedBrush ArtWhere do I post a TwistedBrush Art
Competition entry?Competition entry?

There is a category in the gallery called TwistedBrush Competition entries. Post your entry
within that category.
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Are there special rules for the TwistedBrush artAre there special rules for the TwistedBrush art
competitions?competitions?

Each month, the rules correspond to the current competition. These rules are always
posted in the Open Art Competition section of the forum. Be sure to review and follow
them before entering a competition.
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How do I create a personal album in theHow do I create a personal album in the
gallery?gallery?

New personal albums are no longer allowed in the gallery. Please post your paintings in one
of the existing categories.
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TwistedBrush UsesTwistedBrush Uses
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Is it possible to convert a photo into a paintingIs it possible to convert a photo into a painting
or sketch with TwistedBrush?or sketch with TwistedBrush?

Yes, there are a number of options available to enhance photos and turn them into
paintings or sketches.

• Using image filters from the Filters > Artistic menu. For charcoals, oils etc. This is a single
click result.

• There are 100's of cloning brushes which give a wider variety of results then the first
option but requires more effort but artist skill isn't required.

• Combining, filters and brushes from the Process - Photo Retouch and Process - Special
Effects ArtSets you can get a wide variety of artistic results.

• Additional brushes, tools and filters through-out TwistedBrush can achieve great results
for example the Blending brushes, Texturize Bump Filter for apply a canvas texture or
Bristle brushes for adding a brush strokes textures.
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ArtworkArtwork
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Do I have full ownership of images that I createDo I have full ownership of images that I create
in TwistedBrush?in TwistedBrush?

Yes, the images you create in TwistedBrush are owned by you.
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MarketingMarketing
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Is there a Press Kit, box shots and screen shotsIs there a Press Kit, box shots and screen shots
we can use for a review of TwistedBrush Prowe can use for a review of TwistedBrush Pro
Studio?Studio?

Yes, a full press kit is available on Pixarra's Press Kit page.
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Reviews and LinksReviews and Links
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Can I include a link to the Pixarra home page orCan I include a link to the Pixarra home page or
the forum?the forum?

Yes please do!
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Are there reviews of TwistedBrush that I canAre there reviews of TwistedBrush that I can
read?read?

Links to some reviews are on the Reviews page of the Pixarra website.
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